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What is NoteCaddy and how does it work?

Automatic Notes

NoteCaddy takes notes for you.  Not just any notes, relevant notes based on actual hands – not stats. 
NoteCaddy reads hand histories, understands what happens, and takes notes on behaviors that are 
significant.  Additionally, users of NoteCaddy can be their own judges of what is important.  NoteCaddy 
is fully programmable and the different combinations of notes that can be taken are in the billions. 
Beyond just taking notes on single instances, NoteCaddy can identify patterns and frequencies that will 
help you understand the way your enemies play to a degree that a HUD alone could never do.  

NoteCaddy is a software application that works primarily with Holdem Manager and Poker Tracker 3.  If 
you’re not familiar with these applications, it is strongly recommended that you read about them so you 
have the foundation to use NoteCaddy.  

Modern day HUDs have improved the art of note taking by allowing you to take notes in their “heads up 
display” (HUD) as well as from their hand replayer.  Now you can review hands that you played and 
write a note and it will appear the next time you are at the table with the player.  So between the power 
the HUD already gives you and the ability to add notes at any time, a player can already gain a nice edge 
over the competition.

NoteCaddy aims to sharpen this edge even further.  Taking notes is tedious work and despite the 
innovation of note functionality, most players still don’t take notes regularly.  Even those who do may be 
taking notes on something that happened one time thousands of hands ago and the player they took 
the note on may not even typically behave the way the note indicates that they do.  In short, just 
because someone takes notes, doesn’t mean they’re getting good intelligence out of it.

But beyond just taking notes on what happened, NoteCaddy takes notes on what almost happened.  For 
example, you may be interested in how an opponent plays draws.  NoteCaddy can take a note for you 
that given a reasonable sample size will look like the following: “Plays draws aggressively (7/9).”  What 
this means is that out of 9 times that a player flopped a flush draw (and eventually showed down), 7 
times the player showed aggression.  This note could also be taken with pairs, sets, air, etc.  Any note 
you can imagine (with the exception of timing tells) can be taken by NoteCaddy.  Where NoteCaddy 
really excels over a human note taker is the ability to purge old notes automatically and add new ones 
from more recent dates to ensure that you always have fresh reads.



Color Coding

Currently, the Full Tilt Poker and PokerStars clients support a feature that allows you to assign colors to 
players.  These colors are then shown at the table where the player sits but more importantly in the 
lobby.  Using the lobby, you can quickly browse through tables and find tables that contain players that 
are of a color that interests you.  Of course, this is also typically done manually and therefore would be 
impossibly tedious to do for tens of thousands of players.  NoteCaddy also makes this task simpler by 
automatically color coding players for you.  As with the notes, this is fully programmable.  Ten of the 
most common stats found in the popular trackers can be used to determine a player’s rating (very 
similar to the auto rating provided by HEM and PT3).  You can also manually create a list of players to 
automatically color code.

Note Synchronization

Many players prefer to see their notes in the poker client rather than part of the HUD.  NoteCaddy 
provides a simple feature to synchronize the notes you have in your database with the notes you have in 
your client file for PokerStars, Full Tilt Poker, and PartyPoker.  This can also be used to make quick 
backups.

System Requirements and Poker Site Support

Before installing NoteCaddy, please ensure that you meet the minimum system requirements.

• Holdem Manager or Poker Tracker 3 must be installed

• PostGre 8.3 or higher

• For windows XP, 1 GB of memory

• For window Vista or Windows 7, 2 GB of memory.  4 GB is recommended

• 10 MB of available disk space

• .NET Framework 3.5 or higher



NoteCaddy supports hand histories from the following poker sites

• PokerStars

• Full Tilt

• Absolute/Ultimate Bet

• PartyPoker

• iPoker

• OnGame

• MicroGaming

• Merge Network

• Bodog

Installing NoteCaddy

Where to download NoteCaddy

To get the NoteCaddy installer, please visit http://www.notecaddy.com/download.aspx and find the link 
that says “NoteCaddy runtime”.  Save this file to your hard drive.  

Once you have saved it, execute it by double clicking:

http://www.notecaddy.com/download.aspx


Next, go through the installation wizard:

Once NoteCaddy has finished installation, it will appear in your Start menu.  To find it, click the start 
button and go to “all programs” then “NoteCaddy”.  In that folder, you’ll see a link “NoteCaddy.exe”. 
Don’t click this yet – there is one more step to ensure that NoteCaddy will have the proper permissions 
to run on your system.  

Assign permissions to NoteCaddy

In your windows explorer (you can press the windows key and “e” at the same time for a shortcut), 
browse to the folder c:\program files(x86)\NoteCaddy:



Next, right click on NoteCaddy.exe and click properties.  Navigate to the compatibility tab and ensure 
that “run this program as an administrator” is checked.

Click OK and then do the same thing for NoteCaddy.MainClient.exe.



Running NoteCaddy for the first time and getting your database 
connections configured

On your start menu, go to all programs, NoteCaddy, and click NoteCaddy.exe.  In a few moments you 
will see a screen that looks as follows:



Once it has loaded successfully, you can click “continue” to be taken to the NoteCaddy main application. 
In the NoteCaddy application, you will be prompted to enter your database credentials on the settings 
screen:

You may not remember the password to your database or even the information relating to your 
database.  In this case, you can retrieve the information from your tracker.



Getting database information from Holdem Manager

Open up the Holdem Manager application and when it finishes loading, go to options->Database 
Management

The fields on this screen map to the first four fields of the NoteCaddy settings screen.



Getting database information from Poker Tracker 3

Database information is most easily obtained by looking directly at your configuration file.  This file will 
typically be located in C:\Program Files (x86)\PokerTracker 3\Data\Config\PokerTracker.cfg or a 
similar location.  If you look around half way down the file, you’ll see a section that looks like this:

[Database]

Default.Postgres.Server=localhost

Default.Postgres.Port=5432

Default.Postgres.User=postgres

Default.Postgres.Password=******

Your password will be in plain text and these fields also map directly to those in the NoteCaddy settings 
screen.

Entering Appropriate Settings 

The NoteCaddy settings screen has a number of options that let you customize its behavior (see below 
screenshot). After you’ve successfully, connected to your database server, the next thing to do is to pick 
which database or databases you will use.  The hands on each database will be scanned and notes will 
be taken and placed.  Additionally, for color coding, each database will be looked at for player stats. 
Once a player is found on one database, NoteCaddy scans all databases and aggregates the found 
statistics so that the most accurate color read can be made.



Add Notes for Hero 

If you would like to analyze your own play, you can select this option and NoteCaddy will take notes 
based on your play.  NoteCaddy determines who the hero is by who has hole cards dealt to them “face 
up”.  You should know that if you select this option, you will end up with a large number of notes on 
yourself since your cards are always known.

Use multithreading for a performance increase 

Modern computers have the ability to run multiple tasks simultaneously thanks to the innovation of 
multiple cores.  NoteCaddy can capitalize on this by spawning an appropriate number of threads for 
your hardware.  This will cause a significant performance increase and is recommended in most cases. 
The only time this should be turned off is if you will be running other CPU intensive tasks and would 
prefer NoteCaddy to use a minimal amount of your CPU time.

Show notification popups when a note is taken 

This is a very powerful feature to have when you are running NoteCaddy while playing.  What this 
feature does is shows a popup similar to the ones instant messenger programs show you when someone 
talks to you.  What this popup tells you is the name of the player, the note that was taken, and the name 
of the table or tournament it was taken at.  With this information, you can immediately review the hand 
for which it was taken if you wish.  Otherwise, you can just rely on the intelligence gained in future 
situations.  However, when creating notes on all of your existing hand histories, this feature can be quite 
a nuisance and should likely be turned off unless you want to look at all the popups to get an idea of 
what types of notes are being taken.



Popup duration 

This setting allows you to specify how long the popup will stay on your screen.  The default of 2 seconds 
may be too short if you play multiple tables.

Overwrite user selected colors in Tilt/Stars notes

When color coding, NoteCaddy will not change the color code if there is a manually entered note 
entered for that user in the client note file.  However, if you select this option, NoteCaddy will overwrite 
the color coding.  This option will ignore any note that has the underscore ”_” character in it.  So if you 
have a single user or a select group of users whose colors you would like to not overwrite, you can 
ensure that the note contains the underscore and it will never be overwritten by NoteCaddy.

Consolidate PT3 notes

Poker Tracker 3 contains a great feature that allows you to show statistics from all of your databases in 
the HUD.  This, however, can cause problems when using NoteCaddy due to the fact that duplicate 
notes may be stored on separate databases.  When you check this box, NoteCaddy will store all notes 
per player only on a single database.

Highlight HEM Notes

A great feature that Holdem Manager has is the ability to put a background image or color behind the 
note icon in its HUD.  NoteCaddy can auto populate that to a red background, increasing the visibility of 
the note, if you select this option.

Perform Logging

If you have some technical problems with NoteCaddy, it may be necessary to enable logging.  This will 
create a file in your NoteCaddy folder that explains in great deal what was occurring within NoteCaddy 
while you had it open.  Emailing this file to support@notecaddy.com will often allow for a quick 
resolution of this issue.  The file will be created with the format.

Stat cache size

For some notes, statistics are taken into consideration.  Since statistics are aggregated based on a large 
number of hands, the process can be very hard work for your hard drive.  Therefore, these statistics are 
cached so that they are subsequently more readily available.  Depending on how much system memory 
you have, you can safely increase this number to ensure that your NoteCaddy performance is the best it 
can be.

Hand buffer size

NoteCaddy grabs hands from your HEM or PT3 database.  However, based on memory limitations, the 
amount that are grabbed is limited.  If your computer has a large amount of memory, you can easily 
increase this number to one million or higher.

mailto:support@notecaddy.com


Filters

By default, NoteCaddy is set to not use filters.  What this means is that all hands will be selected and 
processed.  You can eliminate hands using the criteria on this screen.  To get to the filters screen, click 
File->Filters in the NoteCaddy main screen.  On the very top of this screen, you will see the two radio 
buttons that determine whether you’ll be filtering or not.

Date Range

Here you can set the minimum and maximum date you would like to use.  This is useful for excluding old 
hands from being considered.

VIP List

If you’d like to only take notes or perform color coding on a select group of players, enter their names in 
the VIP List box and all other players will be ignored for both note taking and color coding.

Sites

If there is a site in your database on which you no longer play, you may wish to exclude it by unselecting 
it in the sites list.

Sample Range

Valid for color coding only, with sample range, you can make sure that players with few hands are not 
given false colors or that players with too many hands are also not color coded.

Game Types

Here you can specify if you want cash games and/or tournaments to be considered for notes and color 
coding.  For color coding, if you have a game type unselected, the statistics will not reflect hands played 
at these levels.

The stakes are shown in terms of big blinds and they ignore currency so a value like “0.50 BB” is 
referring to .25/.50 dollars, euros, GBP, etc.



Note Grouping

One of the key features in NoteCaddy is to be able to group notes.

As NoteCaddy takes a large number of notes on players, keeping them organized is very important. 
What Note Grouping allows you to do is to group and sort notes by any criteria that you wish.  That way 
when you have a tough flop decision, you can scroll down past the pre flop (or not) notes and see what 
his flop tendencies tell you about him.  As with nearly everything in NoteCaddy, this is customizable. 
When you cover note definition scripting later in this manual, you will see how you can add group types 
to the list in the above screen shot.  For now, it is important to understand that, by default, notes will be 
grouped by the appropriate street that NoteCaddy auto assigns to them.  So for example if a note on 
continuation betting is taken, it will have an [F] in front of it, indicating it is relevant to the flop.  The 
letter M is used for reads that were not taken by NoteCaddy.

Additionally, you have the option to automatically append the size of the game for which a note was 
taken.  So the above example for continuation betting could end up reading “[F][6m]Continuation bets 
wet flops too often(7/8)”

Of course you have the option to change the order in which they appear by using the arrows to the right 
of the list seen in the above box.  It is possible to see flop actions before pre flop actions if you choose.



Creating Notes for Your Hands

Before embarking on the challenge of creating your own note definitions, it is recommended that you 
let NoteCaddy generate some notes on your database using the definitions it includes by default.  The 
reason for this is so that you understand how many notes will be taken for each player and what the 
notes will actually look like.  This will give you a feel for how NoteCaddy works and you will be able to 
more intelligently create your own definitions.

So once you’ve finished with your settings and filters, you can click the “Start” button on the main 
screen.  The first thing NoteCaddy will do is establish which hands it be processing and making a list of 
hands.  This process can take some time (especially on laptops!) but eventually your NoteCaddy will look 
like this:

You will know how the process is going since the screen attempts to stay communicative at all times. 
Once you have a thousand or so notes added, it is recommended that you stop the process and assess 
how it worked.  To do this, go to File->Synchronize->Export Notes to text file.  When you click this, it will 
prompt you on whether or not you’d like to include manually entered notes in the export.  For this 
example, it is recommended that you click no.  

Depending on how many notes have been added, this process could take a few minutes.  Once it 
finishes, it will pop up an alert telling you that it has finished.  Once you click OK, you can look at a text 
file that shows all notes that NoteCaddy has created.  You should analyze this file.



Creating notes from hand history files

NoteCaddy gives you the option to bypass your database and use the hand history files generated by 
poker sites.  This should be used if you’ve purged the hand histories out of your database as part of 
maintaining it.  The players in the hand histories must also exist in your database otherwise no notes can 
be taken on them.

Resetting Notes

In many cases, you may want to purge from your database the notes that NoteCaddy has created.  This 
can be done very easily by going to File->Reset notes.  This will not impact notes that you had manually 
entered but all NoteCaddy notes will then disappear and you are free to start generating notes for your 
whole database again.

Definition Scripting

By far the most powerful feature of NoteCaddy is the ability to create customized definitions for notes 
that NoteCaddy should take.  The sky is the limit for unique definitions and when properly used, this 
feature can prove itself to be incredibly useful.  To view the scripting screen, click Tools->Scripting.  The 
amount of fields on this screen may seem a bit overwhelming at first.



In reality, there is logic behind each field that is relatively easy to follow.  Also, there are tool tips for 
many items that can help you.  What is important is to understand the concepts.

When you create a new definition, it is like a sculpture where you start with a big rock and whittle it 
down to exactly what you want.  More specifically, a brand new definition with nothing changed will be 
applied to every player in every hand that is played.  It is unlikely that anyone would want this definition 
at all.  So, just to clarify, when all check boxes are checked in a section, it means that it doesn’t matter 
what happened with respect to that.  Also, if a text field has the number 0 in it or is blank, that also 
indicates that it will be ignored when it is time to determine whether a player’s performance in a hand is 
“noteworthy”.   The objective of the script writer is to single out noteworthy behavior and to identify 
which actions constitute it.

A definition consists of a name, a description, and then a large amount of options.

Variables



Variables are words preceded by the dollar sign ($) that are entered into the note description.  When 
the note is taken, the variable is replaced with a value depending on what happened in the hand.

$pfposition

This will reflect the pre flop position a player had.  So for example you could enter “limped from 
$pfposition” into the description a note might be taken saying “limped from UnderTheGun”

$stacksize

If you use this variable, it will be replaced with a generalization of the player’s stack size.  The 
generalized stack sizes can be viewed in the Pre Flop->General tab.  For example you could enter 
“shoved from $pfposition $stacksize deep” and a note might be taken “shoved from Button 1-5 BB 
deep”.  Typically, this variable is used by tournament players where stack size is very important.

$cards

This variable will show the actual cards the player had.  For example you could enter “shoved $cards 
from $pfposition $stacksize deep” to get a note like “shoved KQo from MiddlePosition 6-8 BB deep”

$pfaction

This variable will write out what the player did pre flop.  A list of all the pre flop actions can be found on 
the Pre flop->Actions tab.  For example you could enter “$pfaction with $cards from $pfposition” to get 
a note like “Cold Called with K7o from Button”

$flopaction, $turnaction, $riveraction

These variables will write out what was done on the flop, turn, or river, respectively.  To view the list of 
post flop actions, check the Flop->Actions tab.

$flophand, $turnhand, $riverhand

This will write out what hand strength the player had on the flop, turn, or river.  The list of post flop 
hand strength can be viewed on the Flop->Range tab.  Note that the river differs slightly in that draws 
are no longer considered relevant.

$gamesize

This will insert the general game size.  The possible values are “hu”, “6m”, or “9m”.  If you’d like to 
differentiate at which game size a note was taken, this is the easiest way.

Opportunities

One of the most powerful elements of definition scripting is the concept of opportunities versus 
instances.  This concept can be a little bit difficult to grasp but an opportunity is basically when all the 
criteria of a note definition have been met – except for one.



This works differently based on if a definition is intended for pre flop or for post flop.  A definition is 
considered a pre flop definition when the last relevant action occurs pre flop. What this means is that 
for flop, turn, and river actions, all check boxes are checked signaling that it doesn’t matter what 
happened on these streets.  For a pre flop action, an opportunity occurs if all else was correct except for 
the cards a player was holding.  So for example, if there is a definition “3 bets UTG raisers light” and you 
define light to mean all hands outside of TT-AA, an opportunity would occur when the player 3 bets an 
under the gun raiser with TT-AA.  So if you see something like “3 bets UTG raisers light(1/9)” in the notes 
for a player, that means there have been 9 times where this player 3 bet an under the gun raiser (and 
showed down), 8 of them were merely opportunities (the player did have TT-AA) and the one time was 
an instance where the players hand was outside of the established TT-AA range.  From this you can 
reasonably conclude that he respects under the gun open raises – information that the players 3 bet 
HUD statistic may not have indicated.

A definition is considered post flop if there needed to occur a specific action or set of actions on any 
street past post flop.  What that means is if you’re interested in how a player value bets the river, this is 
a post flop definition.  The same goes for if you select only a flop continuation bet.  For an opportunity to 
occur, everything must occur except for the last action.  That means if you have a definition “raises cbets 
with draws” and the player just calls a cbet with a draw, it is considered an opportunity.  However, if you 
have a definition that says “2 barrels with air” and the player fails to continuation bet, it is not an 
opportunity even if everything else was correct including the player having made a turn bet and the 
player not having made a significant hand.

Criteria Fields

The power of note definitions comes from the ability to specify a series of things that need to be true in 
order for something to be considered noteworthy

Result

This field simply allows you to specify whether a player won the hand or lost.  Having both check boxes 
checked indicates that it doesn’t matter whether or not the play won the hand or lost it.

Game Type

Here you can specify whether a hand had to come from a cash game or tournament.  Additionally, you 
can specify what type of tournament it had to come from.  It is important to verify that NoteCaddy can 
recognize your hand histories correctly by using the Test Environment, which will be covered later in this 
document.

Tournament Speed

For cash games, this is ignored.  However, for tournaments, this indicates whether your definition will 
apply only to regular speed, turbos, hyper turbos, etc.  The generic naming is due to the fact that every 
site has its own term for speeds.



Sample Filters

This feature is more powerful than it first appears.  With this, you can take notes based on things 
happening too often or not often enough.  You can ensure that outliers do not clutter your valuable 
reads.

Minimum Occurrences

This is simply the amount of times a definition has to have been taken before it will show up in 
someone’s notes.  If you have regular players in your database with thousands of hands, you may not be 
interested in a particular behavior that only occurred once.

Minimum Player Hand Sample

Closely related to minimum occurrences, this is the amount of hands a player has to have in their 
database in order for the minimum occurrences to take effect.  For example, you may wish to have any 
note taken for a player with whom you’ve never played, but for the regular you know well you want 
more specific information.  So if you set this to 1000 or more hands, then anyone with less hands than 
that is exempted from the minimum occurrences rule.

Warning: Setting minimum occurrences requires NoteCaddy to pull a player’s stats from the database 
which will cause a noticeable slowdown in processing time.

Minimum Success Percent

You may wish to not show a note if the ratio of instances to opportunities is below a certain value.  Here 
you specify a percentage (0-100) as a minimum.

Grouping

As discussed in the grouping section, this is a way to keep notes organized.  By default, NoteCaddy will 
attempt to auto detect which grouping prefix a definition should get.  However, the algorithm for 
detecting this is not perfect so when writing definitions, it is prudent to specify the correct value for 
yourself (PF, F, T, R).

Additionally, you may wish to define your own classifications and this is the place to do so.  For example, 
if you’d like to group notes that involve a 3 bet, you could set this to 3B and that section would then 
appear in the groupings screen and you could specify an order for it.



The Pre Flop Tab

This tab shows general items relating to pre flop criteria.

Position

Here you can specify the position a player has to have been in.  Note that for heads up, only small blind 
and big blind count.  Also, for full ring, anyone after under the gun and before cutoff are considered 
middle position.

Stack Size in Big Blinds

This is an easy way to specify a general stack size range that a player must have.  Most useful for 
tournament players, this can also be used for cash games to write notes based on how players behave 
with deep stacks.

Manual Stack Size Specification

If the generalized stack sizes are not quite right, you can enter numbers to specify an exact minimum 
and maximum amount of big blinds that a player must have to be considered for this note.

Game Size

If you’d like a note to only be taken for a certain game size, this is where you can set that.

Blinds

Here you can specify the big blind of the actual game.  So if you want to a note to only apply where the 
blinds are $1/$2 or $2/$4, you can put 2 and 4 in these fields, respectively.

Final Pot Size

Sometimes you want to be somewhat vague, for example “plays big pots with weak pairs”.  Here you 
can specify a minimum and maximum final pot size.

Player had to show down

It is recommended that you check this off anytime you’re concerning yourself with a player’s range.  The 
reason being that if a player shows a bluff, it may throw off the intelligence that NoteCaddy gathers 
since the player can obscure the range of hands he shows when not required.

Player had to get all chips in pre flop

If your interest is just to say something like “all in pre flop with 99 deep stacked”, this is the easiest way. 
When you check this, it doesn’t matter if the player got it in by raising, reraising, calling, etc.

Cards



This is a pretty simple section.  Here you simply specify a range of hole cards the player had to have in 
order for the definition to be applicable.  As always, leaving all boxes checked indicates that the specific 
hole cards a player had were not relevant.

Previous Actions

Arguably one of the most powerful features of NoteCaddy scripting – previous actions are actions that 
must have occurred prior to a player’s final pre flop action.  These are not typically required but there 
are definitely situations where they are.  An example of when it is not required is if you are writing a 
definition based 3 betting or cold calling.  If you specify a 3 bet in actions (not yet covered), NoteCaddy 
infers the fact that there was a raise ahead of it and therefore it typically isn’t required that you specify 
here that a raise occurred.

However, if you want to specify a definition relating to 3 betting under the gun raisers as opposed to a 
cutoff raiser, then you do need a previous action since NoteCaddy can’t infer which position you want 
covered without it.  Additionally, you can specify that the previous actor was of a particular “color read”. 
Color coding, which is covered later, allows you create classifications based on standard HEM/PT3 
statistics.  Therefore you could make a definition “3 bets tight UTG raisers light from the button”.  It is 
the previous action that allowed you to specify that the previous actor was both under the gun and a 
tight player.

Actions

Here you specify what the player had to do pre flop.  As usual, leaving all boxes checked (except for Fold 
which is a special case) will indicate that it doesn’t matter what the player’s actions were pre flop.  The 
potentially confusing actions all have tool tips to help you.

The fold action is a special case.  If you check fold, it means that no matter what else happened, the 
player had to have folded pre flop in order for this definition to apply.  Selecting a range of check boxes 
typically indicates that only one of them has to be true but if you check fold, then there has to be a fold.

The Post Flop Tabs

The tabs for the flop, turn, and river are almost identical so they will be covered all together in one 
section.  The post flop tabs are divided in the same way as the pre flop tabs by general, range, previous 
actions, and actions.  The general tab contains mostly information about board texture but some other 
things as well.

Players Seeing Flop

Here you can specify whether a hand went to the current street heads up more multi way.  If you’d like 
to take notes on how players play in multi way pots, this is the way to do it.

Position

This is simply to specify whether a player had to be in position or out of position.  If you’d like to specify 
that a player checks behind strong, then you would definitely specify in position otherwise, notes might 
be taken on players who check raised since the check part is true.



Board Texture

You can be very specific about what types of board textures are acceptable for a note definition here.  If 
you are going to use this, it is strongly recommended that you familiarize yourself with the texture test 
which will allow you to determine what types of hands constitute what textures.

Player had to get all chips in on the flop/turn/river

Identical to the pre flop version, this simply means that one way or another the player got all his chips in 
on the flop.

Player put no money on flop/turn/river

This is used to indicate that a player “shut down” in a certain situation.  This means that if a player could 
check, he did, otherwise he folded.  It is the easiest way to specify that a player shut down given the 
nature of the “fold” check box in the actions tab.

Range

For the flop and turn, this is divided into made hands and drawing hands.  The river doesn’t have 
drawing hands since draws aren’t relevant on the river.  You can pick one or many possible hands that 
the player needs to have for a definition to apply.  Additionally, you can also specify a general strength 
which lets you pick a number 1-100 for the players needed hand strength.  You can learn what 
card/board combinations constitute specific hands and general strengths using the test tool found on 
the bottom right.

Warning: it is not recommended that you use general strength since it requires a large number of CPU 
cycles to determine a player’s general hand strength.  For performance reasons, it is recommended 
that you use the check boxes.

Previous Actions

This works identically to the pre flop previous actions tab so please see that section for more details.

Actions



This also works identically to the pre flop actions, just with more options.  The flop actions tab has tool 
tips that can help you distinguish what types of bets/raises constitute which classifications.

As with the pre flop actions tab, if you check fold, it means that the player has to fold.

Definition Scripting Tutorials

In this section, you will follow along as some definitions are scripted and then you will test them against 
your own database.

Beginner: Posts out of turn
This note will be taken for any player who sits at the table and doesn’t wait for turn to post the big blind 
but rather posts dead.  His impatience is a strong indicator of a weak game and we want to know this.

In the scripting screen, type “PostsOutOfPosition” in the text box in the top left corner.  Then click the 
“new” button next to it.  You have created the definition but now need to modify a few things:



In the general tab, you will need to put some text that will go in the actual notes box.  Here you should 
enter “posts out of turn”.  Next, ensure that “Take notes for opportunities” is not checked as it isn’t 
really possible to measure how often someone could have posted out of position.  Next, go to the Pre 
Flop->Actions tab and click the “unselect all” button.  Now click only the “posts out of turn” box.

Now click the save button and your definition is complete.  You’ll notice that we didn’t specify what hole 
cards the player had or what his subsequent actions were.  What matters in this case is only that there 
was a post out of position.

Of course we want to test our definition to make sure the kinds of situations that we expected appear. 
On the bottom left of the form, there is a button labeled “seek”.  Click this button.  It will ask you if you 
want it to mark opportunities.  In this case we will click no, because we’re not interested in the missed 
opportunities.  Once you do, NoteCaddy will begin scanning through your database to find appropriate 
situations.  You will be updated in realtime on how many hands have been found.  Once you’re satisfied 
with the sample size, you can click “finish” and have the hands shown to you in a text window.

Novice: Calls open raises with small pocket pairs from the blinds

For this definition we will specify a few more criteria than for the last.  However, we will leave all the 
post flop tabs with their default settings.



In the top left text box, enter the text “CCWithSmallPPFromBlinds” and click the “new” button.  In this 
example, we do want to take notes for opportunities.  A note “CC small PP from blinds(3/5)” would 
indicate that out of the 5 times there was a showdown after the player called a raise from the blinds, 3 
times he had a small pocket pair.  This gives us a good idea of what his cold calling range is from the 
blinds”

In the general tab, make sure that “take notes for opportunities” is checked and that you’ve entered 
appropriate text in the description box.  It is also prudent to manually set the “grouping prefix” to 
ensure that it is grouped properly.

Next we move to the Pre Flop->General tab.  Here we want to uncheck all the position boxes except for 
small blind and big blind.  Additionally, we want to remove heads up from the eligible game sizes. 
Finally, we want to check off “player had to go to showdown” so that the player doesn’t have a chance 
to skew our perceived range by selectively showing bluffs.



So now we’ve indicated that a player must be in the blinds in a game with at least 3 players and had to 
have shown down.  Now let us move to the Pre flop->Cards tab.  We will save some time by clicking the 
“unselect all” tab and then checking off the boxes for 22 through 66.



So far now we’ve specified that a player must be in the blinds in a game with at least 3 players, has to 
have shown down 22-66.  Finally, we will specify that the player has to cold call a raise.  The Preflop-
>Actions tab gives us three different open raise sizes to have called (Cold Call Min Raise, Cold Call Raise, 
Cold Call Oversize Open Raise) we will check off all three.  However, it is reasonable to not want this 
note to be taken for players having called minraises so it would make sense to uncheck that box.

So now we’ve painted the picture that we were looking to paint and are ready to save and verify the 
correctness of the definition.  When you click Seek, it will ask you if you’d like to have opportunities 
reported as well.  If you click yes, you’ll notice that the vast majority of the notifications you get will be 
opportunities.  You should review the hands and determine if you really want to take this note.  If 
players are getting the note “CC small PP from blinds(1/7)” it isn’t really giving you a good enough idea 
of their range.  At the very least, you may want to consider using the “minimum success percentage” 
found in the general tab.

Intermediate: Raises continuation bets light on low wet flops

This definition will involve a few more steps than the last but is still fairly straight forward.  We are 
looking for players who cold call a raise pre flop and then raise a continuation bet on a flop that is more 
likely to have hit a typical calling range than a typical raising range.  However, what we want to know is 
that this player did it with a weak hand rather than something strong.

In the text box on the top left enter “RaisesCbetsLightOnLowWetFlops” and click the “new” button.



On the general tab, enter “raises cbets light on low/wet flops” for the description and check off “take 
notes for opportunities”.  For grouping prefix enter “F”.

Your general tab should look like the above image.

Next we move to the Preflop->General tab.  Here we will indicate that the player had to show down and 
we will remove heads up from the list of game sizes.



We will skip over cards because we’re much more interested in how the player flopped than we are 
what his starting hand was.  For actions we will put the same calling actions as we did in the last tutorial



Now we go to flop->general and define what exactly a “low/wet” flop is.  For face cards, we uncheck all 
boxes except for “no face cards”.  For board pairing, we uncheck all boxes except for “none”.  For flushes 
we uncheck “none” and for straights we do the same.  So what we’re saying is we want no face cards, no 
board pairing, and at least 2 to a flush and 2 to a straight for our flop texture.

Next we go to the Flop->Range tab and define what we consider a light range.  See the below screen 
shot for what you should put.  As you can see, I have put middle pair or worse and very weak draws.



Finally, we go to the Flop->Actions tab.  Here we will select all raises and check/raises.  There is a button 
towards the top that says “unselect all”.  Click it and then click the button that says “select all raises”. 
You will still need to select the check raises manually but they are two rows above the raises so it should 
be fairly simple.



Now we’re ready to save an test.  In this case an opportunity would mean that a player called a 
continuation bet weak on the “low/wet” board.  We are interested in this so we click “seek” and click 
yes when prompted if we want to see opportunities.  You may find that the count of opportunities is 
greater than the actual instances.  Either way, this can provide us valuable information about players 
who like to call weak on these boards.

Intermediate: Continuation bets too often on Ace or King high flops

This definition will show another powerful feature of the NoteCaddy scripting engine – the ability to only 
show notes when they have done something too often.  Here we are looking for players who are too 
comfortable continuation betting on ace or king high flops.  These players might assume that their 
opponents will be scared off since aces and kings will often hit a pre flop raisers range much better than 
they do a cold calling range.

We will start by typing “CBetsAorKFlopTooOften” into the text box at the top left then clicking the 
“new” button.  Next we go to the general tab and type “Cbets A/K high flops too often” into the 
description text box.  Check off “take notes for opportunities” so that we can see the frequency of this 
action.  Next, we move down to sample filters and set the minimum occurrences to 10 and minimum 
success percentage to 80.  What we are saying with this is that we are only interested in seeing this if 



the player had at least 10 opportunities to do so and 8 out of the 10 times he actually did it.  Of course if 
there have been 20 opportunities, we want at least 16 instances, otherwise the note will disappear 
again.  We want to make sure the notes we have are based solid intelligence, not anomalies.  Finally, 
enter “F” for grouping prefix.

Next, we move to Pre flop->Actions and check off all the standard open raises.



We won’t specify a range for hole cards because we’re not actually interested in a player’s range.  This 
note will be based strictly on frequency.  

Next we move to the Flop->General tab.   In this tab, we will uncheck “Queen/Jack High” and “No face 
cards” in the high card section and leave everything else as is.



Finally, we move to the Flop->Actions tab and select only the standard bets.



So now we’ve created a potentially useless note on a player continuation betting ace or king high flops 
and turned it into a very powerful note to have due to the fact that we are informed how often it 
happens and what type of sample size we’re looking at.  If you do a “seek”, you will find this note will 
come up very frequently.  That doesn’t mean each instance would show up in your notes.  Remember it 
has to happen at least 8 out of 10 times.

Advanced: Floats tight players light on dry flops

This is a very specific note that would be taken fairly rarely.  However, it is something we’re interested in 
because typically when you see a flop like A73 rainbow, it is not particularly dangerous to continuation 
bet.  What we’re looking for here are players that know this and know you know this and will try to 
outplay you.

On the top left text box, enter “FloatsTightPlayersLightOnDryFlops” and click the “new” button.  Go to 
the general tab and for description enter “floats tight players light on dry flops”.  Also check off “take 
notes for opportunities”.  For grouping prefix, enter “T”.



Next, go to the Pre flop->General tab and remove the blinds, remove heads up, and check “player had to 
show down”.



Next, go to actions and uncheck everything except the standard cold call boxes 



Next go to the flop->General tab and specify “in position”.  For pairings, allow there to bet one pair or 
none, for high card select only Ace High or King High.  For flushes, select none.  For straights allow two 
straight or none.



Now we go to flop->previous actions.  Here we will create a required previous action named CBet.  In 
the text box labeled description in the gray area, enter “CBet”.  For color reads, select “ABC”, “TAG”, and 
“Rock”.  For action, unselect all then select small bet, medium bet, pot size bet, and oversize bet.  Now 
click the button labeled “save new” on the bottom right.  We have now specified that a tight player has 
to have continuation bet.



Next we go to Flop->Actions.  Here we select the call boxes that correspond to a single bet.



For the turn, we will be very liberal about what we allow.  We’ve already specified that the player must 
be in position and that it needs to be a dry flop.  We’re not particularly concerned with what the turn 
brought in this case and we don’t need to specify again that the opponent is a tight player.  So really the 
only thing we need to do for turn is specify that the player bet, everything else is deduced.  For example, 
for the player to bet, he has to have been checked to.  If he was in position on the flop, he still has to be 
in position on the turn.  We could specify all these details if we want to but it just means more work for 
NoteCaddy which means more waiting for you.  So we’ll just skip to Turn->range and pick a pretty weak 
range.



Finally, we want to specify that there was a bet so we go to the Turn->actions tab and just specify the 
standard bets



Now we can save and seek.  In this case, missed opportunities would mean that the player checked 
behind weak in this same situation.  Since this definition is so specialized, it will likely take some time 
until a suitable hand is found in your database.

The Test Environment

In the previous section, you saw how you could use the “seek” function to search your database for 
hands that would match a definition.  However, if you have a specific hand that you want to analyze, the 
test environment is what you want to look at.

The test environment is very simple.  You just paste a hand history and it gives you a full analysis.



Here you can see the actions committed by each player and, if it is known, their hand strength.  More 
importantly, it gives you a break down for why each note definition was not applicable.  That way, you 
know what to adjust in your definition if it isn’t working as you expected it to.  If a definition was 
considered valid for a player, it will say “SUCCESS”

Color Coding

NoteCaddy can automatically color code PokerStars and Full Tilt poker players based on their statistics. 
By default, NoteCaddy ships with definitions that match Holdem Manager’s “Auto Rate” rules. 
Therefore, if you’re satisfied with these ratings, performing color coding can be a fairly simple process.

From the NoteCaddy main window, go to Tools->Color coding to open the color coding screen.  From 
here you can see that the options are fairly straight forward.  You may see duplicate items on the left. 
The reason for this is because there may be more than one set of criteria constitute a certain definition. 
For NoteCaddy, these are different definitions.  However, if you give them the same name and 
description, they will function as if they were a single definition with multiple sets of criteria.



You can select one of eight different colors to assign to a player type.  Next, you type a description.  For 
PokerStars, you can export this description to the client so when you hover the mouse over a player, it 
will tell you what classification you’ve given them.

Player List

If you enter names here, it will ignore all other players.  Only players on the list could possibly be eligible 
for the color definition but if you’ve specified other rules, then these must also apply.

Priority

Sometimes more than one rule can apply to a player.  When running the color coding process, it will 
stop once it finds a definition that applies to a player.  Set the priority number to greater than zero and 
it will check this definition against players before those with a 0 priority.

Exempt from Color Coding

Although this seems counter intuitive, there is a good use for it.  If you want to write a customized color 
definition to be used in a note definition but not for color coding, this is where you would do it.  For 
example, if you want to take a note on how a player plays against aggressive opponents, you could 
create a color definition, specifying only a high Aggression % and then use it in a note definition.



Statistics

It is recommended that you view the FTR dictionary to learn more about the statistics 
http://www.flopturnriver.com/poker-dictionary/.  This dictionary is very comprehensive and will allow 
you to understand the use of each of the statistics.

In NoteCaddy, you set a minimum and maximum allowable value for each statistic.  Setting a number to 
0 will cause it to be ignored.  Sample size works similarly to opportunities does in note definitions.  This 
is simply how often a player could have performed the action.  So for example, for three bets, the 
sample size is simply how often a player faced a raise pre flop.

Running the Color Coding Process

Go to either the PokerStars or Full Tilt poker tab and enter the name of the file that you’d like to modify. 
The tool tip for the “note file” field will give you hints on where you can find it.  Here you can select if 
you want cash game and/or tournament players to be color coded.  For PokerStars you can elect to 
“export color definitions as note labels”.  This will allow you to hover the mouse over a player at the 
table or in the lobby and to see the description of the definition by their name.

Once you’ve configured everything the way you want, click start.  The first thing NoteCaddy does is to 
create a backup of your existing note file.  This way if you’re not satisfied with what NoteCaddy 
produces, you can restore your notes easily.  The backed up file will be placed in a folder called 
note_backups that resides in the same folder where your note file is.  NoteCaddy will alert you when it is 
finished color coding your players.

Manual Color Coding

NoteCaddy allows you to manually modify your notes files without having to work in xml.  Simply go to 
the manual tab and type the partial name of a PokerStars or Full Tilt player.  NoteCaddy will search your 
database and return matches.  Select a player and you are given their information on the “Notes” 
section of the screen.

http://www.flopturnriver.com/poker-dictionary/


Here you will see what color is assigned to them and the notes they have in the client’s note file.  You 
can modify the color and/or the text if you wish and click “save” to persist this information back to the 
client note file.


	
	What is NoteCaddy and how does it work?
	Automatic Notes
	Color Coding
	Note Synchronization

	System Requirements and Poker Site Support
	Installing NoteCaddy
	Where to download NoteCaddy
	Assign permissions to NoteCaddy

	Running NoteCaddy for the first time and getting your database connections configured
	Getting database information from Holdem Manager
	Getting database information from Poker Tracker 3

	Entering Appropriate Settings 
	Filters
	Note Grouping
	Creating Notes for Your Hands
	Creating notes from hand history files
	Resetting Notes

	Definition Scripting
	Variables
	Opportunities
	Criteria Fields
	Sample Filters
	The Pre Flop Tab
	The Post Flop Tabs


	Definition Scripting Tutorials
	Beginner: Posts out of turn
	Novice: Calls open raises with small pocket pairs from the blinds
	Intermediate: Raises continuation bets light on low wet flops
	Intermediate: Continuation bets too often on Ace or King high flops
	Advanced: Floats tight players light on dry flops

	The Test Environment
	Color Coding
	Running the Color Coding Process
	Manual Color Coding


